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電路板設計國際能力認證學科試題 400 題題庫 
 

答

案 
題號 題   目 

C 1 

如下圖  為何種元件之符號 

(A) 發光二極體 (B) 光電晶體 (C) 光耦合器 (D) 雷射二極體。 

B 2 

下圖 IC 符號第一支接腳位置在 

 
(A) A 腳 (B) B 腳 (C) C 腳 (D) D 腳。 

C 3 

下圖元件符號為 

 
(A) N 通道 JFET (B) P 通道 DE-MOSFET (C) N 通道 E-MOSFET (D) PNP 電晶體。 

B 4 

下圖電子電路符號為 

 
(A) 電壓源 (B) 電流源 (C) 伏特計 (D) 安培計。 

D 5 

下圖符號為 

 
(A) 電燈 (B) 電話端子盤 (C) 電力分電盤 (D) 電力配電盤。 

A 6 

下圖所示之 C L K 端的三角符號表示？  

 
(A) 邊緣觸發  (B) 重設控制  (C) 延遲輸入  (D) 單向導通。 

Ｄ 7 

下圖所示之符號為？ 

 
(A) 紅色指示燈  (B) 白色指示燈  (C) 黃色指示燈  (D) 綠色指示燈。 

C 8 

可交、直流兩用的電表，其面板上的符號為？ 

(A)                 (B)               (C)                (D) 

            
A 9 下圖為何種之電路符號？ 
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(A) 傳輸閘  (B) 緩衝器  (C) 放大器  (D) 非反相器。 

A 10 

下列圖示哪一個是 PNP 電晶體？ 

(A)            (B)              (C)              (D) 

              

B 11 
如下圖符號中，若輸入均為”1”，試問輸出為  (A)0  (B)1  (C)不確定  (D)高阻抗  。 

..

1

2
3

 

A 12 

如圖為發光二極體(LED)之符號，其順向切入電壓約為 1~2V，所以如要使 LED 發光，則直流電

壓  (A)A 端加正電壓、B 端加負電壓  (B) A 端加負電壓、B 端加正電壓  (C)只要加上直流電壓

即可發光  (D)足夠的電流即可  。
 A B。 

B 13 
如下圖，為何種元件之符號？  (A)發光二極體  (B)光二極體  (C)紅外線二極體  (D)雷射二極

體  。     A K。 

B 14 

如下圖所示的電晶體為何種電晶體？  (A)單載子電晶體  (B)光電晶體  (C)功率電晶體  (D)穩壓電

晶體。 
.

.  

D 15 

下圖電路符號為何種邏輯閘？ 

 
(A) 反或(NOR)閘  (B) 或(OR)閘  (C) 互斥或(XOR)閘  (D) 反互斥或(XNOR)閘。 

B 16 

請問下列電路符號為何種邏輯閘？ 

 
(A) 高電位動作的三態閘  (B) 互補式輸出的緩衝器(buffer)  (C)反(NOT)閘 (D) 低電位動作的三態

閘。 

D 17 

請問下列電路符號為何種邏輯閘？ 

 
(A) 高電位動作的三態閘  (B) 互補式輸出的緩衝器(buffer)  (C)反(NOT)閘  (D) 低電位動作的三態

閘。 

C 18 

下圖是什麼正反器？ 

 
(A) 無預置/清除的負緣觸發 D 型正反器  (B) 有預置/清除的負緣觸發 D 型正反器  (C) 有預置/清

除的正緣觸發 D 型正反器  (D) 無預置/清除的正緣觸發 D 型正反器。 

A 19 下列符號為哪一種類的排阻？ 
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(A) A type  (B) B type  (C) C type  (D) D type。 

B 20 

下列符號為哪一種類的排阻？ 

 
(A) A type  (B) B type  (C) C type  (D) D type。 

D 21 

下列符號為哪一種類的排阻？ 

 
(A) A type  (B) B type  (C) C type  (D) D type。 

A 22 

下列符號是哪一種零件的符號？  

 
(A) 共陰極七段顯示器 (B) 共陽極七段顯示器 (C) 蕭特基二極體 (D) 稽納二極體。 

B 23 

下列符號是哪一種零件的符號？  

 
(A) 共陰極七段顯示器 (B) 共陽極七段顯示器 (C) 蕭特基二極體 (D) 稽納二極體。 

A 24 

下圖符號為？ 

 
(A) 直流電壓源  (B) 交流電壓源  (C) 保險絲  (D) 指撥開關。 

C 25 

下圖符號為？ 

 
(A) 直流電壓源  (B) 交流電壓源  (C) 保險絲  (D) 指撥開關。 

D 26 

下列何者為電解電容？ 

    (A)                (B)                (C)                (D) 

                 

B 27 

下圖為哪一種電路？ 

 
(A) 稽納整流  (B) 橋式整流  (C) 濾波整流  (D) 半波整流。 

D 28 下圖為哪一種電路？ 
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(A) 稽納整流  (B) 橋式整流  (C) 濾波整流  (D) 半波整流 

D 29 

代表何種邏輯閘？ 

 
(A) 及(AND)閘  (B) 反(NOT)閘  (C) 或(OR)閘  (D) 互斥或(XOR)閘 

A 30 

何者為史密特閘？ 

(A)                            (B)                             (C)                             (D) 

             

B 31 

如圖 ，   與下列何者相等? 

(A)                 (B)  

(C)               (D)  

C 32 

下圖電路可取代何種邏輯閘? (A)AND  (B)OR  (C)NOT  (D)XOR 

 

B 33 

下圖符號為？ 

 
(A) 水泥電阻  (B)可變電阻  (C) 固定抽頭電阻  (D) 熱敏電阻。 

A 34 

下圖符號為？ 

 
(A)電感  (B)電阻  (C) 電容  (D) 電磁線圈。 

D 35 

下圖符號為？ 

 
(A) 發光二極體  (B)光電晶體  (C) 電解電容  (D)太陽電池。 

C 36 三用電表面板上有一鏡面是為了避免(A) 儀器誤差(B) 系統誤差(C) 視覺誤差(D) 殘餘誤差。 

D 37 
關於邏輯測試棒，下列敘述何者錯誤? (A)可測 High 電位 (B)可測 Low 電位 (C)可測Ｐulse (D)可

測電壓大小。 

A 38 
三用電表的直流電壓檔，其實際值所測得的電壓為？(A)平均值 (B)有效值 (C)峰值 (D)峰對峰

值。 
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D 39 

下列何者不是手工具的選擇與使用原則？ 

(A) 選擇適合工作所需的標準工具  (B) 選用正確的方法使用工具  (C) 工具應保持定期保養使用  

(D) 選用價格低廉為主，而不需考慮其材質。 

B 40 

欲使用電源供應器產生雙電源（±5V）輸出供應系統電路，正確的作法為下列何者？ 

(A) 兩組各自獨立電源調整輸出  (B) 串聯同步調整輸出 (C) 並聯同步調整輸出(D) 重複固定 5V

電源供應兩次。 

D 41 
檢測數位邏輯電路最簡易的工具為？ 

(A) 示波器  (B) 邏輯分析儀  (C) 三用電錶  (D) 邏輯探棒。 

D 42 
下列哪一種儀器可以用來測量邏輯狀態的變化？ 

(A) 計數器  (B) 訊號產生器  (C) Ｑ表  (D) 邏輯探棒。 

D 43 
欲測量電路上匯流排是否正常傳送，應使用何種儀器？ 

(A) 三用電表  (B) 訊號產生器  (C) 頻譜分析儀  (D) 邏輯分析儀。 

C 44 數位 IC 測試器無法測試下列何種 IC  (A)74LS32  (B)7447  (C)NE555  (D)4017。 

B 45 下列何者為觀察振盪訊號之儀器 (A) 訊號產生器 (B) 示波器 (C) 振盪器 (D) 三用電表。 

C 46 
示波器面板上有一訊號端子，CAL 0.5V p-p，係為 (A) 校準輸入 (B) 接地用  (C) 校準輸出 (D) 微

調端子。 

D 47 
示波器水平基準線傾斜時，應使用起子調整 (A) 垂直掃描時間(B) 水平掃描時間  (C) 焦距(focus) 

(D) 旋轉 (Rotation) 鈕。 

C 48 
訊號產生器（Singnal Generator），其 SYNC 端子是用來輸入何種訊號？ (A) 垂直訊號 (B) 水平

訊號 (C) 同步觸發訊號 (D) 彩色同步訊號。 

D 49 下列何種儀器是比較型儀表(A) VTVM(B) 示波器(C) 三用電表(D) 惠斯頓電橋。 

A 50 大部份示波器大都採用(A)靜電聚焦(B)電磁聚焦(C)感應聚焦(D)凸透鏡聚焦。 

D 51 示波器的校正輸出一般輸出波形為(A) 正弦波(B)三角波(C)脈衝波(D) 方波。 

A 52 微動開關上註明甚麼的記號，其意是指在正常狀態下是導通的(A)NC  (B)NO  (C)COM  (D)ON 。

C. 53 

邏輯分析儀是一種類似於示波器的波形測量設備，可測量功能下列敘述何者正確？ 

同示波器測量功能  (B) 同數位電表測量功能  (C) 只能測邏輯準位 0 和 1(D) 只能測量 DC 電壓和

電流。 

C 54 二極體編號為 1N4001 中的”1N”代表  (A)輸入  (B)順向  (C)1 個接合面  (D)1 安培的耐流 。 

C 55 
二極體編號為 1N4003 中的”4003”代表額定電流以及額定反向電壓 (A)1A、50V  (B) 1A、100V  

(C) 1A、200V  (D) 1A、400V 。 

C 56 若使七段顯示器的 a、b、c、d、g 段通電，則會顯示哪個數字？  (A)5  (B)4  (C)3  (D)2 。 

C 57 要讓七段顯示器顯示數字 2，試問要讓哪些腳通電？  (A)cdefg  (B)acdfg  (C)abdeg  (D)abcdef。 

B 58 

通常數位 IC 的哪一隻腳位，被封裝為 IC 的電源供應(Vcc)腳位？ 

 
(A) A  (B) B  (C) C ( D) D。 

C 59 
編號 7805 與 7912 IC 之輸出電壓各為何？ 

(A) +5V、+12V  (B) -5V、+12V  (C) +5V、-12V  (D) -5V、-12V。 

C 60 
若有一電阻上面所示之色碼誤差之顏色為銀色，則其誤差值為百分之幾 (A) 1  (B) 5 (C) 10 (D) 

15。 

D 61 大部份 DIP 封裝的 14 PIN TTL 74 系列 IC 接 Vcc 的接腳為第幾腳？ (A) 1 (B) 7 (C) 8 (D) 14。 

B 62 麥拉電容器上標示 4 7 4K 則電容量為(A)0 . 0 4 7 (B)0 . 4 7 (C)4 . 7 (D) 4 7 μ F 。 

B 63 五個色環為精密電阻器其誤差為 1 ％ 應用何種顏色表示(A)黑(B) 棕(C)紅(D)橙。 

A 64 常用 74 系列雙排包裝(DIP)的腳距為(A) 0.1 吋(B)0.2 吋(C)0.3 吋(D) 0.4 吋。 

D 65 
發光二極體所發出光的顏色與  (A)外加電壓的大小有關  (B)外加電壓的頻率有關  (C)通過的電

流大小有關  (D)製造的材料有關。 

B 66 
電晶體編號 2SA×××中，英文字母中的 A 代表  (A)NPN 電晶體  (B)PNP 電晶體  (C)N 通道 JFET 

(D)P 通道空乏型 MOSFET。 

A 67 
電阻的色碼為紅紫橙紅，試問其電阻值最大值可能為  (A)27.5K  (B)27.0K  (C)37.5K  (D)18.5K 

Ω。 
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D 68 
色碼電阻的阻值為 69.8KΩ 0.1%，試問其色碼為何？   (A) 藍白灰紅棕  (B) 藍灰白橙紅  (C)綠

白灰橙藍  (D) 藍白灰紅紫。 

D 69 

此一包裝方式為？ 

 
(A) PGA  (B) TQFP  (C) BGA  (D) DIP。 

D 70 

此一包裝方式為？ 

 
(A) TSOP  (B) TQFP  (C) TO-5  (D) SOT-223。 

B 71 

此一包裝方式為？ 

 
(A) TSOP  (B) TQFP  (C) TO-5  (D) SOT-223。 

A 72 

此一包裝方式為？ 

 
(A) TSOP  (B) TQFP  (C) TO-5  (D) SOT-223。 

C 73 

此一包裝方式為？ 

 
(A) DIP  (B) TO-5  (C) TO-8  (D) TO-220。 

D 74 

此一包裝方式為？ 

 
(A) PGA  (B) TQFP  (C) TO-8  (D) PLCC。 

B 75 

此一包裝方式為？ 

 
(A) DIP  (B) TO-5  (C) TO-8  (D) TO-220。 

D 76 
電容若標示為 203，則表示電容為多少 μＦ？ 

(A) 0.1  (B) 1.0  (C) 0.047  (D) 0.02。 

B 77 
功率電晶體 TO-3 的包裝中，外殼通常是電晶體的哪一極？ 

(A) 基極  (B) 集極  (C) 射極  (D) 正極。 

A 78 
若某一電阻的色碼，顏色分別為黃、紫、金、紅，它的電阻值為？ 

(A) 4.7Ω±2%  (B) 5.7Ω±3%  (C) 6.3Ω±2%  (D) 6.2Ω±5%。 

C 79 功率電晶體之鐵殼，可視為此電晶體之(A)E 極(B)B 極(C)C 極(D)固定用或作為接地端。 

C 80 電晶體各極判別以何種方法為宜(A)背誦來判別(B)分類來判別(C)電表實測判別(D) 標示判別。 

D 81 

IC 座包裝方式有許多種，如：DIP、LCC、PLCC、PGA、ZIF…等，一般 IC 插入 IC 座後，若欲

拔除則需花很大力氣，一不慎很可能就傷及作業人員或 IC，那一種 IC 座是屬於沒有插入力的

包裝？ (A) DIP (B) LCC (C) PLCC (D) ZIF。 



7 

D 82 
印刷電路板(PCB)在進行佈線(LAYOUT)時，下列那一種線最粗(A)位址線  (B)信號線  (C)CLOCK

線  (D)電源線。 

C 83 電容為 104J 表示容量為 0. 1 uF、誤差為何？(A) ±1%  (B) ±2%  (C) ±5% (D) ±10%。 

C 84 
容量小的電容其容量值在電容上用字母表示或數字表示，其中數字表示 102 為多少電容量？(A) 

0.1 uF  (B) 100pF  (C) 1000pF  (D) 0.01 uF。 

D 85 

關於印刷電路板敘述下列何者錯誤? (A) 種類可分為單面板、雙面板、多層板、軟式電路板 (B) 

其基板是以不導電材料所製成的 (C) 簡稱 PCB 或 PWB (D) 若其電子產品功能越複雜、迴路距離

越長、接點腳數越多，PCB 所需層數越少。 

A 86 關於軟式印刷電路板特性下列何者錯誤? (A) 重量重 (B) 體積小 (C) 可撓性 (D) 可彈性。 

A 87 電解電容器之兩極導線較長一端為(A)正極  (B)負極  (C)無意義  (D)與廠商設計無關。 

A 88 發光二極體之兩極導線較長一端為(A)正極  (B)負極  (C)無意義  (D)與廠商設計無關。 

D 89 在 IC 接腳中，NC 表示 (A) 接地 (B) 接正電壓 (C) 接負電壓 (D) 空接。 

A 90 下列何者代表光敏電阻(A)Cds  (B)Diode  (C)LCD  (D)LED。 

D 91 表面黏著技術的電阻、電容尺寸規格下列何者為非? (A) 0201  (B) 0603  (C) 1206  (D) 1212 。 

A 92 下列何者非 SMD 鉭質電容尺寸規格(A) TANE  (B) TANB  (C)TANC  (D)TANDSOT 。 

A 93 下列何者非表面黏著技術元件特性(A) 體積大 (B) 抗震能力強 (C) 重量輕 (D)高頻特性好 。 

B 94 二極體表面上之帶狀標誌表示此端為(A)正極  (B)負極  (C)無意義  (D)與廠商設計無關。 

B 95 
量測電晶體 C.B.E 腳位適用下列何種儀器? (A) 邏輯探棒 (B) 三用電表 (C) 示波器 (D) 邏輯分析

儀。 

C 96 四個色環為精密電阻器其誤差為 10 ％ 應用何種顏色表示(A)金(B)棕(C)銀(D)橙。 

B 97 五個色環為精密電阻器其誤差為 0.05％ 應用何種顏色表示(A)黑(B)灰(C)紅(D)綠。 

B 98 
IC 7447 是一個 BCD 解碼器，可將 BCD 碼轉換為七段顯示器所需之訊號。因此，IC 7447 的資

料輸出腳數量為 (A) 8  (B) 7  (C) 4  (D) 3 支。 

C 99 一般 DIP 包裝的 IC 兩鄰近接腳的距離是 (A)1mil (B)10mil (C)100mil (D)1000mil。 

D 100 二極體 1N4004 耐壓 (A)50V (B)100V (C)200V (D)400V。 

B 101 矽二極體的順向偏壓近似多少 V? (A)0.25 (B)0.7 (C)5.0 (D)2.0。 

C 102 電容器上標示 202，則其電容量為幾 PF? (A)20 (B)200 (C)2000 (D)20000。 

C 103 七段顯示器的共腳(共陰或共陽)常位於  (A)外側左 (B)外側右 (C)中間腳 (D) 二側旁腳。 

C 104 請問一顆 7 段顯示器，共有幾支接腳?  (A) 8  (B) 9  (C) 10  (D) 11。 

C 105 大部份 DIP 封裝的 16 PIN TTL 74 系列 IC 接 GND 的接腳為第幾腳 (A) 6 (B) 7 (C) 8 (D)9。 

D 106 下列何者封裝方式非表面黏著技術? (A) TQFP  (B) TSOP  (C) SOT-223  (D) DIP 。 

B 107 

關於 BGA 的描述下列何者錯誤? 

(A) 成品設計直徑約 8~12mil (B) 晶粒底部以直線方式佈置許多錫球 (C) 與 TSOP 封裝相比，具

有更小的體積與散熱 (D) 主要應用高密度產品，如晶片組、CPU、Flash 等。 

A 108 
常用的 DIP 封裝符合 JEDEC 標準，二接腳之間的間距(腳距)為?  

(A) 0.1 吋 (B) 0.2 吋 (C) 0.3 吋 (D) 0.4 吋。 

C 109 
零件包裝為 0805，下列何者不是它的特性？ 

(A)兩銲點之間的距離為 80 mil (B)為 50mil 方形的銲點 (C)為 5mil 方形的銲點 (D)是 SMT 零件。

C 110 
為何現在的電子產品的零件多為 SMT，下列哪一不是它的發展原因？ 

(A)縮小產品的體積 (B)增加零件布局的密度 (C)容易進行電路板的布線 (D)減少鉛錫的使用量。

B 111 

SMT 表面黏著元件和 THT 插件式元件相比較，下面那一敘述不對？ 

(A) SMT 比 THT 的零件要小 (B) SMT 比 THT 的零件要貴 (C) SMT 技術使得在 PCB 板上的零件

要比 THT 的密集很多 (D) SMT 比 THT 的零件要薄。 

C 112 SMD 電阻上面數字為 472 之元件的阻值？(A) 472 Ω (B) 470 Ω (C) 4.7 KΩ (D) 47 KΩ。 

C 113 下列何者是積體電路中最常製作的元件？(A)變壓器 (B)電感 (C)電晶體 (D)電容。 

A 114 

據報導指出：台積電與聯電在 90 奈米製程世代發展至今已步入成熟階段，產能比重均已大幅

提高。這裡所指的 90 奈米，為何種尺寸？ 

(A)電晶體的閘極長度 (B)電容器的絕緣層厚度 (C)電路的金屬線寬度 (D)金屬間的連結栓直徑。

B 115 下列何者不是用 SMT 表面黏著技術？(A)PLCC (B)DIP (C)BGA (D)SIP。 

B 116 在積體電路中，以下何種元件最難製造？(A) 電阻 (B) 電感 (C) 電晶體 (D) FET。 

B 117 下列何種不是表面黏著技術(SMT)固定零件時使用?(A) 助銲劑 (B) 快乾膠 (C) 錫膏 (D) 錫油。 

D 118 
下列何者不是表面黏著技術(SMT)的優點 

(A) 可雙面黏著 (B) 線路的密度更高 (C) 產品更輕巧 (D) 抗雜訊更佳。 

D 119 下列何者不是電子零件的封裝方式(A) BGA (B) PGA (C) PBGA (D) LPGA。 
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C 120 
符號「DIP20」，意思為何? 

(A)目標位址值為 20 (B)零件數值為 20KΩ (C)零件外型為雙排共 20 支接腳 (D)零件序號。 

D 121 
零件包裝符號「0805」，意思零件長寬尺寸為何? 

(A) 0.8mm*0.5mm (B) 0.8cm*0.5cm (C) 0.8inch*0.5inch (D) 80mil*50mil。 

B 122 下列哪一種機器，不屬於 SMT 產線?(A)錫膏印刷機 (B)錫爐 (C)取置機 (D)迴銲爐。 

C 123 IC 中的導線架常使用下列那一種材料？(A) 鐵合金 (B) 鎳合金 (C) 銅合金 (D) 銀合金。 

D 124 請問 0805 的 SMT 電阻在攝氏 70 度下，其額定功率為：(A)1/20W (B)1/16W (C)1/10W (D)1/8W。

B 125 請問以下何種材料使用在 IC 的封裝技術上:(A)橡膠 (B)陶瓷 (C)金屬 (D)玻璃。 

C 126 以下何者不是電子元件包裝規格？(A)DIP (B)TO-5 (C)LINE (D)TO-220。 

D 127 
MC78M05BT 穩壓 IC 的散熱片與哪一腳連接？ 

(A)輸入 (B)輸出 (C)沒有與任何接腳相連 (D)接地。 

C 128 2N3055 功率電晶體的包裝規格為(A)TO-72 (B)TO-220 (C)TO-3 (D)TO-5。 

C 129 

SMD 元件之外形尺寸、封裝與功率之對應關係為何？ 

(A)0402 為 1/8W (八分之一瓦) (B)  1206 代表公制單位 (C)0805 代表 2.0mm x 1.2mm (D)0603 代表

銲點大小。 

B 130 
電阻元件封裝 AXIAL0.3 之意義何者正確？ 

(A) 長方形貼片 (B) 成軸狀 (C) 間距為 3mm (D) 表面贴片式元件。 

D 131 
PLCC 元件封裝之意義何者正確？ 

(A) 扁平封裝 (B) 四側接出 L 形引腳 (C) 玻璃環氧纖維封裝 (D) 引脚中心距 1.27mm。 

D 132 
標準雙排式封裝(Dual In-Line Packaging，DIP)IC 如圖所示 G 的長度為何? 

(A)1mm (B) 1.54mm (C)2mm (D)2.54mm。 

C 133 

如圖所示之零件封裝名稱為 (A)TO-92 (B)TO-220 (C)TO-3 (D)TO-252。 

B 134 
表面貼裝電組規格為 1206，“1206“代表的意義為 

(A)電阻值 (B)零件尺寸 (C)製造日期 (D)公司代號。 

B 135 須要零件密集的電路板常用之零件為(A) THT (B) SMT (C) SYM (D) TQC。 

D 136 
IC 包裝類別TSOP、PLCC、DIP、SOP、QFP、uBGA、PGA，那些是針腳貫孔銲

接 THT 元件。(A)  (B)  (C)  (D) 。 

B 137 
IC 包裝類別TSOP、PLCC、DIP、SOP、QFP、uBGA、PGA，那些是表面銲接

SMT 元件。(A)  (B)  (C)  (D) 。 

C 138 一般 14pin DIP 包裝 IC 座兩排接腳間的距離是(A)1000mil (B)500mil (C)300mil (D)100mil。 

C 139 SMT 包裝 0805 的電阻相當幾 W 的電阻？(A)1/2 W (B)1/4 W (C)1/8 W (D)1/10 W。 

B 140 
下列哪一種電子元件封裝其引腳密度最高? 

(A) SOJ 封裝 (B) BGA 封裝 (C) DIP 封裝 (D) PLCC 封裝。 

D 141 SMT 包裝 0603 的電阻相當幾 W 的電阻？(A)1/2 W (B)1/4 W (C)1/8 W (D)1/10 W。 

B 142 
一平方公尺面積單面覆蓋銅箔重量 1oz(28.35g)的銅層厚度。請問一盎司（oz）等於多少密爾

(mil)厚度？(A)1.2 (B)1.4 (C)1.6 (D)2.0。 

B 143 下列何者不是印刷電路板常用的金屬塗層？(A)金 (B)鎳 (C)銅 (D)錫。 

A 144 
印刷電路板(PCB)材料核心為基板材，最常見的基板為銅箔基板(CCL)。CCL 主要原料為銅箔和

什麼組成？(A) 玻璃纖維布 (B) 紙漿 (C) 樹脂 (D) 鋁板。 

C 145 
在多層板 PCB 中下列何者是將幾層內部 PCB 與表面 PCB 連接的方法？ 

(A)導孔(via) (B)埋孔(Buried vias) (C)盲孔(Blind vias）(D)穿孔(Through holes)。 

A 146 

在雙面板 PCB 中，兩面的導線需相連時，必須要在兩面間有適當的電路連接才行。這種電路

間的「橋樑」叫做 

(A)導孔(via) (B)埋孔(Buried vias) (C)盲孔(Blind vias）(D)穿孔(Through holes)。 

C 147 
下列何者不是單面板應用之優點 

(A)單面走線 (B)厚度較雙面板及多層板薄 (C)熱傳導較雙面板及多層板慢 (D)可承載零件。 

D 148 

工廠在打件前，會先針對 PCB 板作哪一項測試，確認面積能夠受熱均勻且不會發生零件空銲

的現象？ 

(A) X-Ray 測試 (B) OPEN/SHORT 測試 (C) ATE 測試 (D) 溫度分佈測試。 
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D 149 
下列 PCB 基板，何者具有可彎曲和可變形的特性 

(A) 電木板 (B) 紙質基板 (C) 玻纖環氧基板 (D) 金屬基板。 

A 150 
下列何種材料將絕緣基板和銅箔黏合製成銅箔基板(Copper Clad Laminate)? 

(A) 環氧樹脂 (B) 甲醛樹脂 (C) 氰基丙烯酸酯 (D) 聚氨酯。 

B 151 
一般雙面電路板設計，並無下列哪一層面 

(A)Top solder mask layer (B)Ground layer (C)Bottom signal layer (D)Top signal layer。 

C 152 哪一種印刷電路板很少被設計或生產(A)單層板 (B)雙層板 (C)三層板 (D)四層板。 

D 153 
下列那一種印刷電路板是軟性電路板？ 

(A) 酚醛紙層壓板 (B) 環氧紙層壓板 (C) 聚酯玻璃氈層壓板 (D) 聚酯薄膜印制電路板。 

B 154 
PCB 製程為了符合歐盟 RoHS 規範，在外層電鍍與表面處理上必須禁止下列何種物質的使用: 

(A) 錫 (B) 鉛 (C) 銀 (D) 金。 

D 155 

在最基本的 PCB，零件集中在其中一面，導線則集中在另一面上。因為導線只出現在其中一

面，所以我們就稱這種 PCB 為(A) 雙面板（Double-Sided Boards） (B) 多層板（Multi-Layer 

Boards） (C) 導孔（via） (D) 單面板（Single-sided）。 

C 156 
一般零件外觀尺寸單位中 1mil 的長度=? 

(A) 1/10 inch (B) 1/100 inch (C) 1/1000 inch (D) 1/10000 inch。 

A 157 

PCB 多層板（Multi-Layer Boards）結構敘述，何者錯誤? 

(A) 通常層數都是奇數，並且包含最外側的兩層 (B) 導孔（via）是貫穿整個板子兩側 (C) 盲孔

是將幾層內部 PCB 與表面 PCB 連接，不須穿透整個板子 (D) 埋孔則只連接內部的 PCB。 

D 158 
硬式電路板幾乎都採用電鍍銅箔，一般厚度是以重量表示(1oz/ft2=1.35mil)下列那一種較不常用?

(A) 1 oz (B) 1/2 oz (C) 1/3 oz (D) 1/4 oz。 

A 159 PCB 銅箔厚度常用的單位是？(A)盎司(oz) (B)mil (C)mm (D)公克。 

B 160 
蝕刻槽的主要功能為?(A) 進行電路圖影像轉移 (B) 將不需要的銅箔去除 (C) 去除影像上殘留的

乾膜 (D) 將基板鍍上一層金屬。 

C 161 

關於外層線路正片與負片何者正確? 

(A) 正片多為鍍錫之抗蝕刻層 (B) 負片多為乾膜之抗蝕刻層 (C) 正片製程之蝕刻液為氯化鐵 (D) 

負片電鍍銅成本較高。 

B 162 
用來保持線路及各層之間的絕緣性，俗稱為基材。在電路板疊層設計，又稱為 

(A)零件層 (B)介質層 (C)電源層 (D)玻璃纖維層。 

A 163 
目前 PCB 板製造商，因板面空間的限制以及線路密度的提昇，所使用的新一代製程技術簡稱

為(A) HDI (B) HCI (C) HHG (D) HCC。 

C 164 

PCB 基板的板層屬性中，下列何者不屬於非電氣板層？ 

(A) 防銲層(Solder Mask Layer) (B) 文字面(Silk Layer) (C) 內層走線層(Inner Layer) (D) 錫膏層(Paste 

Layer)。 

A 165 印刷電路板製程中的底片曝光是採(A) 紫外線 (B) 紅外線 (C) 白光線 (D) 黃光線。 

B 166 
下列何者不是銅箔基板(Copper Clad Laminate)的蝕刻製程之一? 

(A) 貼附蝕刻阻劑 (B) 噴錫 (C) 曝光顯影 (D) 蝕刻。 

A 167 電路板鑽孔後上下層需要電鍍導通，業界表示符號為何?(A)PTH (B)NPTH (C)VIA (D)PAD。 

A 168 

雙面電路板製做，下列何者流程較正確? 

(A)裁板→鑽孔鍍銅→線路蝕刻→防銲綠漆→文字印刷 (B)裁板→線路蝕刻→鑽孔鍍銅→防銲綠

漆→文字印刷 (C)裁板→防銲綠漆→鑽孔鍍銅→線路蝕刻→文字印刷 (D)裁板→文字印刷→鑽孔

鍍銅→線路蝕刻→防銲綠漆。 

A 169 

在 PCB 製程中的防銲製程是將防銲漆覆蓋於 PCB 板表面，其主要目的是防銲、護板及絕緣，

請問對防銲漆使用的品質要求標準為何? 

(A) IPC-SM -840C (B) IPC-CC -830A (C) IPC-HM-860 (D) IPC-TF-870。 

D 170 

何者不是 PCB 面文字面印刷模糊、殘缺、偏位其原因 

(A)菲林制作網面偏位，定位孔不良 (B)印刷時比印網不良 (C)PCB 背面不光潔，機板變形 (D)字

型錯誤。 

B 171 

在電路板的插接端點上（俗稱金手指）鍍上一層高硬度耐磨損的鎳層及高化學鈍性的金層來保

護端點及提供良好接通性能稱為 

(A)噴錫 (B)鍍金 (C)預銲 (D)碳墨。 

B 172 
PCB 外層線路完成後需再披覆絕緣之樹酯層，其主要用途為何？ 

(A) 保持線路顏色一致 (B) 避免氧化及銲接短路 (C) 增強張力與彈性 (D) 兼具防水與防火功能。

D 173 
在電路板之銲接端點上，以熱風整平之方式覆蓋上一層錫鉛合金層，其功能為何？ 

(A) 增加厚度與寬度 (B) 防止元件短路 (C) 美觀與強化結構 (D) 提供良好之銲接性能。 
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C 174 

AOI (Automated Optical Inspection)是自動光學檢查技術，AOI 在下列哪一個 PCB 製程缺陷檢測的

準確率最低? 

(A)缺件(Missing) (B)偏斜(Skew) (C)錫橋(solder bridge) (D)墓碑(tomestone)。 

A 175 PCB 多層板材質為全玻璃纖維者，其名稱為(A) FR-4 (B) FR-1 (C) CEM-3 (D) CEM-1。 

D 176 
PCB 零件之銲接, 基本上以何種方法為主? 

(A) 錫爐銲接 (B) 迴銲銲接 (C) 烙鐵銲接 (D) 高週波銲接。 

D 177 
將 1000 伏特電壓導入 PCB 上相臨電路或板層做電性檢驗，在幾秒內不能產生火花或損壞？ 

(A)5 (B)10 (C)20 (D)30。 

D 178 下列軟體何者不適用於電路圖繪製?(A) PADS (B) OrCAD (C) Protel (D) AutoCAD。 

A 179 PADS Logic 電路繪製的文件屬性為?(A) sch (B) pcb (C) asc (D) lib。 

B 180 PADS 適用於何種工程之設計軟體?(A) 電力分析 (B) 電子線路 (C) 機械結構 (D) 建築設計。 

C 181 PADS Logic 中，設定 Display Grid 為 100，則為幾公分?(A) 2.54 (B) 100 (C) 0.254 (D) 10。 

D 182 
PADS Logic 中若要變更元件外觀，使其產生垂直鏡射的效果，可使用何種快速鍵組合? 

(A) Ctrl+Tab (B) Ctrl+R (C) Ctrl+F (D) Ctrl+Shift+F。 

A 183 

PADS Logic 中如何清除螢幕殘留影像? 

(A) Refresh <End>  (B) Add Connection <F2>  (C) Option <Ctrl+Enter>  (D) Zoom <Ctrl+W> 

。 

B 184 
在 Pads Logic 繪製電路圖時要偏移畫面，若按著 Shift 鍵，同時滑鼠中間的滾輪往前滾動，則畫

面哪方向往中間偏移？(A)往上 (B)往左 (C)往右 (D)往下。 

A 185 

在 Pads Logic 設定格點(Grids)有設計格點(Design)值、信號名稱及文字格點(Labels and Text)值及

顯示格點(Display Grid)值，若 Snap to Grid 勾選時，是針對哪一格點值做 Snap 的功能？ 

(A)Design (B)Labels and Text (C)Display Grid (D)Design 和 Display Grid。 

C 186 
在 Pads Logic 設計公司特色的圖框，利用 Add Filed  加入特殊字串，下列哪一特殊字串不

在 Add Filed 的清單中？ 

(A)File Name (B)Company Name (C)Draw Name (D)Scale。 

B 187 

在 Pads Logic 的環境下，下面有一個輸出視窗(Output Window)，進行實時對話說明，會用不同

顏色說明不同訊息，下列哪一個是正確的？ 

(A)紅色代表有訊息(Messages)產生 (B)藍色代表連結(Link)到某一檔案 (C)黑色代表有警告

(Warnings)產生 (D)綠色代表有錯誤(Errors)產生。 

C 188 

在 Pads Logic 的環境下，要選擇物件時有一個物件過濾器(Filter)，可使我們正確選到要的物

件，功能表列的 Edit/Filter 可打開 Filter 視窗，下列哪一快速鍵也有同樣功能？ 

(A)Ctrl+F (B)Ctrl+Alt+ E (C)Ctrl+Alt+ F (D)Ctrl+E。 

A 189 

在 Pads Logic 繪製線路圖時，74LS244 的實體包裝 DIP20 要換成 SO20WB，下列哪一步驟是正

確的？ 

(A)點選 74LS244 後，按滑鼠右鍵→點選 Properties→選按 PCB Decals 按鈕。 

(B)點選 74LS244 後，按滑鼠右鍵→點選 Properties→選按 Attributes 按鈕。 

(C)進入 File→Library，出現 Library Manager 視窗→選按 Decals 按鈕。 

(D) 進入 File→Library，出現 Library Manager 視窗→選按 Logic 按鈕。 

C 190 

在 PCB 上進行零件佈局時，那一項敘述是錯的？ 

(A) 輸入和輸出元件應盡量遠離 (B) 易受雜訊的零件不能相互靠得太近 (C) 易發熱的零件，可裝

在印刷電路板上 (D) 高電壓的零件應佈置在維修不易觸及的地方。 

B 191 
使用 4 層電路板來分開 PCB 上不同性質的電路，通常中間兩層會作為那一層？ 

(A) 訊號層 (B) 電源層 (C) 文字層 (D) 防銲層。 

B 192 
PCB 的設計流程有幾個步驟，分別為(1)網絡表輸入、(2)檢查、(3)電路圖底片檔輸出、(4)零件

佈局、(5)佈線，請正確排出先後順序？(A) 12345 (B) 14523 (C) 54213 (D) 31452。 

C 193 
印刷電路板佈線時，導線轉彎處一般如何處理？ 

(A) 以鈍角來轉彎 (B) 以直角來轉彎 (C) 以圓弧來轉彎 (D) 以鈍角來轉彎。 

D 194 

下列那一項不是鋪銅的主要原因？ 

(A) 對於大面積的地或電源鋪銅，具有遮罩作用 (B) 增加散熱功能 (C) 信號完整性要求，給高頻

數位信號一個完整的回流路徑 (D) 增加美觀。 

B 195 
印刷電路板繪製軟體：PADS、Protel 等，製作完成之電路圖輸出成光學底片，大都採用何種資

料格式？(A) PCX (B) Gerber (C) Bitmap (D) True Type。 

B 196 下列那一種軟體雖具有繪製電路圖功能，但無法直接轉 PCB Layouts？ 
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(A)OrCAD (B)AutoCAD (C)Protel (D)PADS。 

D 197 
PADS Logic 中有關於零件未放置前之快速鍵何者有誤？ 

(A)Ctrl+Tab：更換零件外型 (B)Ctrl+R：旋轉 90° (C)Ctrl+F：水平鏡射 (D)Ctrl+Alt+F：垂直鏡射。

D 198 
在 PADS Logic 的 Setup/Design Rules 設定的規則下列那一個子功能設定後何者無法套用到 PADS 

Layout 使用？(A)Default (B)Class (C)Net (D)Differential Pairs。 

B 199 

在 PASD 的 Export 按鈕的功能是輸出物件，而在不同狀態下，所輸出的檔案及物件則有所不

同。請問，關於以下輸出的延伸檔名何者錯誤？ 

(A) 零件包裝檔之延伸檔名為「*.d」 (B) 零件檔之延伸檔名為「*.g」 (C) 非電氣圖案之延伸檔

名為「*.l」 (D) 零件圖案檔之延伸檔名為「*.c」。 

D 200 
在零件包裝設計精靈裡的 BGA/PGA 頁裡，若 Staggered Rows 選項，則會有什麼效果？ 

(A) 挖空接腳 (B) 新增接腳列 (C) 刪除接腳列 (D) 採用階梯式接腳佈置。 

D 201 
PADS Logic 繪製電路圖時，下列何者不具有放大的功能? 

(A) Page Up 鍵 (B) Ctrl 鍵 + 滑鼠滾輪 (C) Ctrl 鍵 + W 鍵 (D) Insert 鍵。 

D 202 
PADS Layout 繪製雙層電路板，在底層走線時欲切換至頂層走線的功能鍵為? 

(A) F1 (B) F2 (C) F3 (D) F4。 

A 203 
PADS Logic 需在什麼狀態下才能新增電源或接地符號﹖ 

(A) 拉連接線狀態 (B) 放置零件狀態 (C) 選擇零件狀態 (D) 選擇連接線狀態。 

B 204 
繪製電路圖時零件的接腳網路名稱(Net Name)相同，表示在電路板編輯時其零件接腳為? 

(A) 相同位置 (B) 互相連接 (C) 相同板層 (D) 線寬相同。 

D 205 
繪製電路圖時預設圖框(Sheet border) 的右下方表格，其中欄位名稱放置文字，欄位內容則放置 

(A) 空白 (B) 文字 (C) 常數 (D) 資料變數。 

A 206 
繪製電路圖時，設計格點(Design Grid)的作用為何﹖ 

(A) 較易接腳連接線 (B) 較易選取零件 (C) 較易修改文字內容 (D) 較易刪除連接線。 

A 207 
零件表列 Q1、2N3053、TO-39，試問 TO-39 屬何項目? 

(A)PCB DECAL (B)Value (C)Reference (D)Part Name。 

A 208 於零件表列中之電阻，何者屬於 Reference 項目?(A)R2 (B)RES-1/4W (C)2K (D)R1/4W。 

A 209 

用來佈線之網路表(Netlist)檔，至少應該包含哪些項目? 

(A)零件序號、零件包裝名稱、網路名稱、連線關係 

(B)零件序號、零件名稱、零件數量、連線關係 

(C)零件序號、零件編號數值、網路名稱、連線關係 

(D)零件名稱、零件包裝名稱、網路名稱、連線關係 

C 210 
表列 Q1-3、J1、J2、R1 R5、R3-4，表示共有幾個零件? 

(A)7 個 (B)8 個 (C)9 個 (D)10 個。 

C 211 

在 PADS Logic 電路圖繪製軟體中，取用有極性電容器 100uF 時，下列何者正確? 

(A)  (B)  (C)  (D)  

A 212 
下列那一個不是 PADS Logic 所能輸出(File Export)的檔案格式？ 

(A) *.eco (B) *.txt (C) *.ole (D) *.asc。 

C 213 

在 PADS Logic 裡要掛/卸零件庫應如何操作？ 

(A) 啟動 Tools/Library…命令 (B) 啟動 Setup/Library…命令 (C) 啟動 File/Library…命令 (D) 啟動

View/Library…命令。 

B 214 PADS Logic 所提供之接地符號有幾種不同外型？(A) 2 種 (B) 3 種 (C) 4 種 (D) 5 種。 

D 215 在 PADS Logic 裡最多可以定義多少個板層數？(A) 100 層 (B) 150 層 (C) 200 層 (D) 250 層。 

B 216 
PADS Logic 產生之 BOM 表儲存在那裡？ 

(A) 使用者指定之目錄 (B) 在 C:\PADS Projects 目錄 (C) 在 D 磁碟中 (D) 以上皆非。 

A 217 

在繪製電路圖時，以下兩個接地符號  與 有何不同? 

(A) 代表 Analog GND， 代表系統 GND 

(B) 代表系統 GND， 代表 Analog GND 

(C) 與 皆代表相同的接地 
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(D) 代表其它 GND， 代表 Analog GND 

A 218 
在 PADS Logic 中，如何更改 Sheet 的名稱? 

(A)Setup->Sheets->Rename (B)File->Sheets->Rename (C)Sheets->Rename (D)Tools->Sheets->Rename。 

A 219 

在 PADS Logic 中，在繪製完電路圖後如何產生 BOM 表? 

(A)File->Reports->Bill of Materials 打勾 

(B)File->Export->Bill of Materials 打勾 

(C)Tools->Layout Netlist-> Bill of Materials 打勾 

(D)File->Creat PDF->Bill of Materials 打勾 

A 220 
請問在 PADS Logic 中，以下那組快速鍵組合可以改變電容元件的外觀? 

(A)Ctr+TAB (B)Ctr+S (C)Shift+TAB (D)Shift+S。 

A 221 

當完成電路圖繪製後，要利用那種延伸檔名將繪製結果傳給 PADS Layout 以進行 PCB layout 的

設計工作? 

(A)ASC (B)REP (C)SCH (D)ECO。 

C 222 
何者不是用來連結二支電氣接腳特性的繪圖工具? 

(A)電氣連接線工具 (B)綱路標籤 (C)繪圖用的畫線工具 (D)繪製匯流排工具。 

D 223 
電路圖轉檔到 PCB Layout 時一般會透過何種檔案執行轉檔動作? 

(A)doc 檔 (B)htm 檔 (C)jpg 檔 (D)net 檔。 

D 224 

階層電路圖檔繪製時應特別那一個細節? 

(A)各模組的外觀 (B)各模組的電路圖檔名 (C)各模組的相關文件注釋 (D)各模組間的電氣信號連

結。 

D 225 
電路圖繪製首要注重那一細節? 

(A)文件注釋 (B)文件版本 (C)零件擺置 (D)各零件間電氣接腳是否連接正確。 

B 226 

製作電路圖之零件時，應清楚交待那一細節? 

(A)電件實際外觀 (B)實際電子零件電氣接腳數 (C)電子零件功能示意圖 (D)電子零件的文件注

釋。 

D 227 
設計一個電路板時那一個不是主要考慮的因素? 

(A)多少佈線層 (B)雜訊免疫力 (C)信號分類 (D)零件 ID 編號擺置。 

C 228 
在 PADS Logic 操作中，設定電路圖名稱應選擇哪一個功能選項？ 

(A)File/Sheets (B)Edit /Sheets (C)Setup/Sheets (D)View /Sheets。 

D 229 
在 PADS Logic 操作中，輸出 PDF 檔應選擇哪一個功能選項？ 

(A)Tools/Create PDF (B)Edit /Create PDF (C)Help/Create PDF (D)File/Create PDF。 

A 230 
在 PADS Logic 操作中，輸出 netlist 檔應選擇哪一個功能選項？ 

(A) Tools/Layout Netlist (B) File/Layout Netlist (C) Edit/Layout Netlist (D) Help/Layout Netlist。 

B 231 
在 PADS Logic 操作中，要載入零件庫應選擇哪一個功能選項？ 

(A)File/Import (B)File/library (C)File/Export (D)File/Create PDF。 

B 232 

在 PADS Logic 操作中，Tools 功能表的 Compare/ECO 功能中 Comparison 標籤有四項可勾選功

能，以下何者不是？(A) Compare Part Attributes (B) Compare Values Attributes (C) Compare Net 

Attributes (D) Compare Design Rules。 

A 233 
繪製電路圖使用可變電阻，調整方向對應增益大小，應將何者標示？ 

(A) 順時鐘方向、逆時鐘方向、電刷之編號 (B) 電阻值大小 (C) 角度與電阻值 (D) 溫度特性。 

C 234 

電路圖繪製應以何者為考量？ 

(A) 盡量將圖放入單一張圖 (B) 由主動元件開始，再畫被動元件 (C) 依系統功能方塊圖擺放相對

應位置 (D) 將相同元件擺在一起。 

B 235 

ADC 元件於電路圖繪製應注意下列那一項？ 

(A) 將其它元件靠近 ADC 排列整齊 (B) 類比接地符號與數位接地符號不同，並單點相連接 (C) 

電源電壓值相同大小 (D) 編號以 U 為起始字母。 

D 236 

數位控制 IC 之旁路電容應繪於何處？ 

(A) 依電壓大小分組排列 (B) 依容量不同分組排列 (C) 排列整齊於電路圖下方 (D) 愈靠近電源與

接地腳位。 

B 237 

多組元件之空餘接腳應如何處置？ 

(A) 標示 NC 符號 (B) 將輸入接腳連至接地或電源之固定電壓 (C) 將輸出接腳串接電阻到接地端 

(D) 將所有輸入端並接在一起。 

C 238 
電路圖之圖紙大小應如何決定？ 

(A) 愈大愈好 (B) 考慮列印能出圖之清晰程度 (C) 印表機或繪圖機最大圖尺寸考量 (D) 以列印紙
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大小來考量。 

A 239 
PADS Logic 繪製電路圖時若要更換零件外型可按? 

(A)Ctrl+Tab (B)Ctrl+R (C)Ctrl+F (D)Ctrl+Shift+F。 

B 240 
若要更換電源或接地的符號，必須在尚未固定位置時按下列那一個鍵來更換? 

(A)Ctrl+R (B)Ctrl+Tab (C)Ctrl+F (D)Ctrl+Shift+F。 

C 241 
PADS Logic 中儲存電路檔的快捷鍵是? 

(A)Ctrl+N (B)Ctrl+O (C)Ctrl+S (D)Ctrl+P。 

B 242 

PADS Logic 中若要載入零件庫必須? 

(A)由 Tools -> Library -> Library List 

(B)由 File -> Library -> Library List 

(C)由 Edit-> Library -> Library List 

(D)不必操作系統會自動加入 

B 243 
PADS Logic 中若要繪製匯流排須選擇下列那一個圖示(A)  (B)  (C)  (D) 。 

A 244 
欲將 PADS Logic 中所繪電路圖轉至 PADS Layout 製作電路板須先產生? 

(A)Netlist 檔 (B)PDF 檔 (C)BOM 檔 (D)PCB 檔。 

A 245 
若已經確定的電路板尺寸，下一步 PCB 設計時須先注意哪一項步驟? 

(A)依要求放置所須定位之零件 (B)有極性元件方向 (C)零件高低大小 (D)佈線距離。 

A 246 
PADS Logic 設計雙層板時，要貫穿 Top 層及 Bottom 層可加入何種方式? 

(A) 導孔(Via) (B) 埋孔（Buried vias） (C) 盲孔（Blind vias） (D) 跳線 (Jump) 

D 247 
PADS Logic 可以產生的 SPICE 格式網絡表，不包含下列哪一種格式? 

(A) Intusoft ICAP/4 (B) Berkeley SPICE 3 (C) PSpice (D) Orcad。 

C 248 
PADS Logic 設計電路時，同一功能的電路元件，有無要求之原則? 

(A) 應均勻分散在 PCB 四處 (B) 應視設計者方便 (C) 應盡量靠近放置 (D) 應從小元件開始放置。

C 249 PADS Logic 設計電路時，跳線不要放在何種元件下面?(A) 固定電阻 (B) 二極體 (C) IC (D) LED。

C 250 
使用 PADS Logic 繪製電路圖時重要的訊號要標示下列，以利繪製 PCB? 

(A)電壓 (B)電流 (C)路徑及線寬 (D)安全距離。 

B 251 
使用 PADS Logic 繪製電路圖基本步驟載入零件庫設定圖紙圖框提取零件及擺置繪製接

線產生網路檔順序 ?(A)  (B)  (C)  (D) 。 

D 252 
PADS Logic 繪圖設定格點，操作步驟是 Tools/Options/???頁， 調整 Grids 框  Design  50 、 Display 

Design 100(A) Line Widths 頁 (B) Text 頁 (C) Design 頁 (D) General 頁。 

B 253 

PADS Logic 為方便繪圖如何設定較佳顯示的游標為 X 型? 

(A)Set/Design Rules… 

(B) Tools/ Options/ General /Cursor 框 Large cross Diagonal 

(C) Tools/ Options/ Design 頁 

(D) Tools/ Options/ General /Cursor 框 Full cross Diagonal 

A 254 

PADS Logic 中可全面性的選取零件、接線、編號等，操控方式是 ? 

(A) 選擇過濾工具列(Selection Filter Toolbar) 點選 Anything 

(B) 選擇電路圖編輯工具列(Selection Filter Toolbar) 點選 Duplicate 

(C) 選擇過濾工具列(Selection Filter Toolbar) 點選 Parts 

(D) 選擇電路圖編輯工具列(Selection Filter Toolbar) 點選 Properties 

B 255 

PADS Logic 是以何種操控導向式來繪製電路，並以 ESC 鍵中斷與停止該操作功能? 

(A)工具導向式(單一繪圖作用) (B)功能導向式(單獨功能作用) (C)物件導向式(隨選隨有作用) (D)

階層導向式(專案層面作用)。 

D 256 電路圖繪製的一般原則下列何者為非?(A)正電在上 (B)負電在下 (C)輸入在左 (D)輸出在上。 

D 257 將第一個 IC 畫在電路圖上常編號為?(A)A1 (B)C1 (C)J1 (D)U1。 

B 258 
在 PCB Logic 裡要讓零件在 Y 軸方向鏡射應? 

(A)按 Ctrl +F 鍵 (B)按 Ctrl +Shift+F 鍵 (C)按 Ctrl +Y 鍵 (D)按 Ctrl +V 鍵。 

C 259 
在 PCB Logic 繪圖中想看所有物件範圍應? 

(A)按 Ctrl +Shift+F 鍵 (B)按 Home 鍵 (C)按 Ctrl +Alt+E 鍵 (D)按 Z+A 鍵。 

B 260 
在 PCB Logic 中欲改變黑底的畫面應? 

(A)按 Ctrl +Alt+E 鍵 (B)按 Ctrl +Alt+C 鍵 (C)按 Ctrl +Shift+F 鍵 (D)按 Ctrl +D 鍵。 

C 261 

在 PCB Logic 中的零件圖編輯下列何者為非? 

(A)採手工繪製是針對非矩形的零件圖 (B)採零件圖精靈是針對矩形的零件圖 (C)採零件圖精靈

是針對多閘的零件圖 (D)繪圖工具是使用 Editing Toolbar。 
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A 262 
在 PADS LOGIC 網格點的設置中,若在鍵入 g 20 表示為? 

(A) Design Grid 為 20 (B) Via Grid 為 20 (C) Display Grid 為 20 (D) Design Grid Only 為 20。 

A 263 

下圖之電路圖的架構為何 

 
(A) 平坦式電路設計(Flat Design) (B) 簡單階層式設計(Simple Hierarchy Design) (C) 複雜階層式設

計(Complex Hierarchy Design) (D) Multi-Channel 式電路圖。 

A 264 

如圖所示為一個正方形的 IC 封裝設計，其中一邊的長度為 1.26 英吋，也就是 1260 mil。若兩排

接腳的間距為 0.94 英吋，各排有 12 支接腳，而接腳間距為 0.1 英吋，如圖所示，X 應為多少？

 
(A) 1100 mil (B) 1200 mil (C) 1300 mil (D) 1400 mil。 

B 265 
設計印刷電路板時，若要防止高頻向外輻散，電路板必須以下列何者標準來設計？ 

(A) EMA  (B) EMC  (C) EMD  (D) EMI 。 

B 266 PADS Layout 選擇匯入的電路圖檔案為?(A) sch (B) asc (C) err (D) rep。 

A 267 

PADS Layout 如何選擇繪製板框工具? 

(A) Drafting Toolbar  (B) Design Toolbar  (C) Dimensioning Toolbar  (D) ECO Toolbar 

。 

D 268 

PADS Layout 如何選擇擺放螺絲孔工具? 

(A) Drafting Toolbar  (B) Design Toolbar  (C) Dimensioning Toolbar  (D) ECO Toolbar 

。 

C 269 
PADS Layout 單層電路板設計中，若發生走線交叉問題，可選擇如何解決? 

(A) Add Corner (B) Add Via (C) Add Jumper (D) Add Arc。 

B 270 
PADS Layout 中何者功能選項可以打散零件? 

(A) Cluster Placement (B) Disperse Components (C) Nudge Components (D) Cluster Manager。 

C 271 PADS Layout 中在移動元件時，可以使用哪個指令方便元件定位?(A) M (B) W (C) S (D) D。 

D 272 

若要設計四層的電路板，請問下列何者為最適當的疊層設計？ 

(A)電源層/信號層/接地層/信號層 (B)電源層/信號層/信號層/接地層 (C)信號層/電源層/信號層/接

地層 (D)信號層/接地層/電源層/信號層。 

A 273 
在 Pads Layout 設計電路板時，若按著 Ctrl 鍵，同時滑鼠中間的滾輪往前滾動，則畫面的現象如

何？(A)放大(Zoom In) (B)縮小(Zoom Out) (C)畫面刷新重畫(Redraw) (D)適當大小顯示(Board)。 

C 274 
在 Pads Layout 疊層設計，若信號層(上)對信號層(下)，佈線原則要一信號層水平佈線，另一信

號層則垂直佈線，是避免產生甚麼效應？(A)電感效應 (B)電阻效應 (C)電容效應 (D)電磁效應。

D 275 

在 Pads Layout 進行佈線之前，要先設定佈線規則，點按功能表的 Setup/Design Rules…，會出現

Rules 視窗。請問在下列哪一個細部設定不是在 Default 的規則架構內？ 

(A)  (B)  (C)  (D) 。 

B 276 
在 Pads Layout 進行自動佈線時，佈線規則為線寬 12 mils、間距 12mils，請問下列何者格點設定

最適當？(A)12 mils (B)25 mils (C)36 mils (D)48 mils。 

B 277 若 PCB 有表面黏著(SMT)的主動零件，為了 PCB 可製造性，則在零件四個角落或印刷電路板四



15 

個角落至少要有幾個校正標記(MARK)？(A)1 (B)2 (C)4 (D)5。 

C 278 
零件佈局時，電解電容不要擺在那一零件的旁邊？ 

(A) 陶片電容 (B) 小功率電阻 (C) 大功率電晶體 (D) 數位 IC。 

D 279 

印刷電路板佈局設計時，對於零件的排列必須考慮那些因素？ 

(A) 是否可以節省電路板的大小 (B) 電壓及接地路徑的線徑大小 (C) 各零件接腳的寬度及孔徑 

(D) 以上皆要考慮。 

D 280 
電路圖在 PCB 佈線(Layout)時，下列幾種佈線，那一種線最粗？ 

(A) 位址線 (B) 信號線 (C) 時脈線 (D) 電源線。 

D 281 

PCB 佈局之前應先考慮什麼？ 

(A) 需考慮電路板外部接線端子的位置  (B) 將元件放置在適當的位置 (C) 需考慮不同性質的電

路應予以適當的區隔 (D) 以上皆要考慮。 

B 282 

較複雜的電路具有三種不同接地佈線配置，其中包含了較易產生雜訊的電路、低階類比訊號處

理電路、高頻數位電路，這三種不同性質電路的地線，應如何處理？ 

(A) 分別拉線，再予以全部連接 (B) 分別拉線、彼此隔離，再以單點方式予以連接 (C) 共同拉

線，全部予以連接 (D) 不需特別處理。 

C 283 

數位 IC 旁的削尖電容(despiking capacitor)其特質為容量小、頻寬高，目的是什麼？ 

(A) 產生雜訊干擾 (B) 降低流過接地阻抗的電流 (C) 提供 IC 開關時的瞬間脈衝電流 (D) 減少接

地迴路的電感。 

A 284 

在 PADS Layout 中若要改變單位下列何者是正確方式？ 

(A)Tools/Options/Global 設定 Design units 選項 

(B)Setup/Design Rules 設定 Units 

(C)Setup/Options/Global 設定 Design units 選項 

(D)Tools/Design Rules 設定 Units 

D 285 

PCB 設計在處理振盪器(XTAL)的信號時要注意什麼？ 

(A)零件與本身信號鋪 GND 銅箔屏蔽 (B)零件下方禁止其他信號線經過 (C)振盪器的兩個信號線

寬、線長盡量一樣 (D)以上皆是。 

B 286 

PADS Layout 在單層佈線的過程中下列何種方式無法添加跳線？ 

(A)在 Design Toolbar 的工具列點按 圖示 (B)Setup/Jumper (C)Ctrl+Alt+J (D)右鍵出現快顯功能表

後點按 Add Jumper。 

C 287 
PADS Layout 共有 4 種視圖模式，若想要以負片視圖模式顯示，下列何者是正確的切換鍵? 

(A)O Enter (B)T Enter (C)C Enter (D)D Enter。 

D 288 

預佈線分析(Pre-Routing Analysis)的功能，以下敘述何者錯誤？ 

(A) 節省自動佈線時間 (B) 防止無法規範的情況發生 (C) 提高自動佈線前可改善的方式 (D) 將所

有問題與解決方法記錄在 Input 視窗。 

C 289 
進行互動式走線時，若要產生彈簧線，需按哪一個組合鍵？ 

(A) Ctrl + A (B) Ctrl + X (C) Shift + A (D) Shift + X。 

A 290 
PCB 基板層面設定參數，不包括下列哪個選項？ 

(A) 顏色設定 (B) 實體厚度 (C) 蝕刻層名稱(Etch Subclass Name) (D) 材質(Material)。 

D 291 
關於 Rotate 90 的功能是將零件逆時針旋轉 90 度，可以按鍵盤上哪個按鍵就能將零件旋轉？ 

(A) Ctrl + A (B) Ctrl + E (C) Ctrl + H (D) Ctrl + R。 

D 292 所謂「Auto Miter」的功能是什麼？(A) 自動拆線 (B) 自動存檔 (C) 自動畫邊 (D) 自動導角。 

D 293 
下列何者不是走線太長所造成的結果﹖ 

(A) 阻抗增加 (B) 抗雜訊能力下降 (C) 成本增加 (D) 散熱不易。 

C 294 
製作高速電路板時為何走線應避免 90 度直角﹖ 

(A) 易導致訊號傳送延遲 (B) 易造成電路板製造困難 (C) 易產生輻射現象 (D) 易造成銅箔脫落。

A 295 

使用貫孔(Via)時 PCB 厚度越薄，其電容效應及電感效應會如何變化﹖ 

(A) 電容效應越小，電感效應也會越小 (B) 電容效應越小，電感效應會越大 (C) 電容效應越大，

電感效應會越小 (D) 電容效應越大，電感效應也會越大。 

B 296 
電路板編輯器(PCB Editor)輸出何種文件適用於製造實體電路板﹖ 

(A) CAD 文件 (B) CAM 文件 (C) CAI 文件 (D) CAS 文件。 

A 297 

在電路板零件佈局時，欲臨時增減零件需做 

(A) 工程變更設計(Engineering Change Order) (B) 工程設計變更(Engineering Design Changes) (C) 工

程變更作業(Engineering Change Operation) (D) 直接增減零件即可。 

D 298 標準 DIP8，其 pin 1 至 pin 4 之距離為何?(A)2.54mm*4 (B)3000mil (C)400mil (D)300mil。 
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D 299 標準 DIP8，其 pin 1 至 pin 8 之距離為何?(A)700mil (B)800mil (C)8000mil (D)2.54mm*3。 

D 300 
設定電路板尺寸如名片大小，板框約若干? 

(A)210mm*350mm (B)2100mm*3500mm (C)210mil*350mil (D)2100mil*3500mil。 

C 301 

以下佈線要求，何者不合一般電路佈線常理? 

(A)VDD 與 GND 走線設為 20mil，其他走線設為 10mil (B)避免直角轉彎走線方式 (C)採取單層板

走線必須安排在 TOP 板層 (D)走線與走線安全間距設為 8mil。 

D 302 

送 PCB 廠製作印刷電路板，不需何種文件資料? 

(A)Drill file(鑽孔資料檔) (B)Gerber file(各層底片資料檔) (C)Aperture file(光圈鏡頭資料) (D)BOM 

file(零件一覽表)。 

C 303 
在 Design Toolbar 功能列中，可對零件任意旋轉為下列那個圖示? 

(A)  Move (B)  Radial Move (C)  Spin (D)  Move Reference Designator。 

B 304 
在 Design Toolbar 功能列中，下列那個圖示可對零件逆時針旋轉 90 度? 

(A)  Move (B)  Rotate(C)  Spin (D)  Move Reference Designator。 

B 305 

在 PADS Layout 電路板設計軟體中，要擺放螺絲孔，應在 ECO Toolbar 工具列下選取那個圖

示?再選取由載入之零件 

(A)  Add Route (B)  Add Com ponent (C)  Rename Net (D)  Change Component。 

D 306 下列那一個符號是 ECO Toolbar？(A)  (B)  (C)  (D) 。 

B 307 在 PCB Layout 裡要移動零件編號位置要按下列那一按鈕？(A)  (B)  (C)  (D) 。 

A 308 在 PCB Layout 裡要佈線要按下列那一按鈕？(A)  (B)  (C)  (D) 。 

D 309 
PADS Layout 在做 PCB 板電路設計時若要在電路板上加入文字要按下列那一按鈕？ 

(A)  (B)  (C)  (D) 。 

C 310 

在四層以上的 PCB Layout 時，會將振盪器、晶體及 Clock 支援電路等放置於單一的區域地平面

上，此一區域需在第一層，請問為何需要此一區域地平面? 

(A)加強振盪器元件的穩固 (B)提升振盪器之接地腳阻抗 (C)用以補捉振盪器內部的 common-

mode RF 電流以減低 RF 幅射 (D)提供適當的元件辨識功能。 

B 311 四層板的 Ground Plane 通常位於第幾層?(A)1 (B)2 (C)3 (D)4。 

B 312 

在電流為 1 安培下，若希望溫度上升不超過攝氏 10 度，請問佈線的銅箔寬度為何?(假設 PCB

之銅箔厚度為 1oz) 

(A)5 mils (B)10 mils (C)15 mils (D)20 mils。 

A 313 

利用 PADS Layout 做 PCB 佈線設計時，以下何者為正確的設計流程? 

(A) Import .asc 檔案->特殊元件定位->其它元件定位->佈線 

(B) Import .asc 檔案->其它元件定位->特殊元件定位 ->佈線 

(C) Import .asc 檔案->佈線->特殊元件定位->其它元件定位  

(D) Import .asc 檔案->特殊元件定位->佈線->其它元件定位 

B 314 

何謂 3-W 法則? 

(A) Trace 間之分隔距離應一倍於單一 Trace 之寬度 

(B) Trace 間之分隔距離應兩倍於單一 Trace 之寬度 

(C) Trace 間之分隔距離應三倍於單一 Trace 之寬度 

(D) Trace 間之分隔距離應四倍於單一 Trace 之寬度 

A 315 

請問下列何者是正確的 Pad 大小與 Hole 大小之間的關係? 

(A) Pad 至少為 Hole 直徑的 1.8 倍 (B) Pad 至少為 Hole 直徑的 1.6 倍 (C) Pad 至少為 Hole 直徑的

1.4 倍 (D) Pad 至少為 Hole 直徑的 1.2 倍。 

C 316 
一般差動信號的 Trace 走線以那種方式最好? 

(A)任意走線方式 (B)兩線走不同方向 (C)兩線並行等距且等長 (D)兩線不並行且等長。 

D 317 

一般處理高頻數位電路零件擺置以那方式較佳? 

(A)較高頻電路放置角落 (B)較低頻電路放置角落 (C)高低頻電路混合擺置 (D)依照電子零件操作

頻率由高頻到低頻方向擺置。 

C 318 四層板中高速 clock 的 Trace 應放置在什麼的位置為較佳方式? 
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(A)與 Power 層相鄰 (B)與 Ground 層相鄰 (C)與完整沒破裂 Ground 層相鄰 (D)與完整沒破裂 Power

層相鄰。 

D 319 
當元件電路及信號連線之速度在多少 Hz 以下時，單點接地是最佳的方式? 

(A)1k (B)10k (C)100k (D)1M。 

B 320 銅在 100MHz 時集膚深度大約在多少?(A)0.066mm (B)0.0066mm (C)0.66mm (D)0.00066mm。 

A 321 
在 PADS Layout 操作中，要輸出 ASC 檔應如何操作？ 

(A)File/Export (B)File/Import (C)File/Create PDF (D)Tools/Export。 

D 322 
在 PADS Layout 操作中，點選任一 Nets，按滑鼠右鍵選擇 Properties 的 Trace Width 時顯示空白

代表?(A) 寬度為 10 miles (B) 寬度為 20 miles (C) 寬度為 8 miles (D) 寬度不一致。 

A 323 在 PADS Layout 操作中，Add Route 的功能鍵為?(A)F2 (B)F3 (C)F5 (D)F6。 

B 324 
最高工作頻率之元件應擺置於 PCB 何處？ 

(A) 接近輸入或輸出端 (B) 內部最中央處 (C) 最外部 (D) 靠近電源端。 

C 325 數位接地與類比接地應如何處置？(A) 任意連接 (B) 多點連接 (C) 單點連接 (D) 環路連接。 

C 326 
有關於蛇形佈線下列敘述何者正確？ 

(A) 增加電感量 (B) 減少資料上昇時間 (C) 蛇形線距最少為線寬之兩倍 (D) 增加阻抗。 

C 327 
佈線成井字形分佈之用途為何？ 

(A) 防止元件碰撞 (B) 美觀 (C) 分佈電流平衡 (D) 增加強度與張力。 

A 328 

為減少無用輻射，時脈信號應如何處理？ 

(A) 不可貫孔至其它層並增加終端電阻 (B) 使用多組旁路電容 (C) 增加電感與電容濾波器 (D) 使

用較寬之導線。 

B 329 
I/O 板邊須鋪銅，並打 via 多個，其功能為何？ 

(A) 避免 PCB 彎曲變形 (B) 防止 ESD 干擾 (C) 散熱 (D) 固定 I/O 板機構。 

B 330 
PADS Layout 中搬移零件若要直接輸入零件座標應先按? 

(A)A 按鍵 (B)S 按鍵 (C)D 按鍵 (D)F 按鍵。 

B 331 
一般採取單層板的走線，所有的走線都安排在何板層進行? 

(A)Top Layer (B)Bottom Layer (C)Paste Top Layer (D)Paste Bottom Layer。 

C 332 PADS Layout 走線時若要輸入線徑寬度可按?(A) R (B) E (C) W (D) Q。 

C 333 
PADS Layout 中使用 Ctrl+F 的功能是? 

(A)零件旋轉 (B)零件鏡射 (C)將零件放罝於 Bottom (D)編輯零件屬性。 

B 334 
PADS Layout 中若要繪製板框須選擇下列那一個圖示?(A)  (B)  (C)  (D) 。 

B 335 

同一類型的元件在電路面板上以相同方向之方式排放較佳之原因，何者為誤? 

(A)加快機器插件速度 (B)節省零件成本 (C)PCB 過波峰銲錫爐時，可減少其暴露在錫流的時間 

(D)檢查錯誤時較容易。 

B 336 
設計 PCB 之電源濾波時，為了考慮較佳濾波效果，濾波電容器位置應設計? 

(A) 離電源輸入端較遠處 (B) 離電源輸入端越近越好 (C) 離負載輸出端越近越好 (D) 並無影響。

B 337 

PCB 之信號線、地線與電源線之線寬敘述，何者最佳? 

(A) 地線＞信號線＞電源線 (B) 地線＞電源線＞信號線 (C) 地線=電源線=信號線 (D) 地線=信號

線＞電源線。 

A 338 

設計 PCB 內部之數位電路與類比電路的共地處理方式? 

(A) 各自分開互不連接 (B) 至多僅能一半面積連接 (C) 至少一半面積連接 (D) 兩者共用同一接

地。 

C 339 

佈線設計完成後，應做檢查佈線設計，以下何者為錯誤原則? 

(A) 類比電路和數位電路部分，是否有各自獨立的地線 (B) 為避免影響銲接品質，字元標誌是

否壓在元件銲接面上 (C) PCB 中是否還有能讓信號線加寬的地方 (D) 電源線和地線的寬度是否

合適。 

D 340 
PADS Logic 基本標題欄記錄與簡述檔名公司版本繪圖者日期版本功能價錢圖

名編號。(A)  (B)  (C)  (D) 。 

C 341 

PADS Layout 放置電子元件的順序原則是有限制位置的與機構有關的有固定零件的主要

(動)元件被動元件外接端測試點。 

(A)  (B)  (C)  (D) 。 

B 342 

PADS Layout 放置電子元件以零件或路徑為主考慮，若以零件為主也要考慮? 

(A)最短路徑及零件分布對稱性 (B)最佳路徑及最短路徑 (C)零件分布對稱性及最佳路徑 (D)零件

分布對稱性及零件分布均勻性。 

D 343 PADS Layout 放置電子元件以零件或路徑為主考慮，若以路徑為主也要考慮? 
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(A)最短路徑及零件分布對稱性 (B)最佳路徑及最短路徑 (C)零件分布對稱性及最佳路徑 (D)零件

分布對稱性及零件分布均勻性。 

B 344 
PADS Layout 放置電子元件的格點較佳設定為? 以方便零件互相對準用。 

(A) 50 Mils (B) 100 Mils (C) 150 Mils (D) 200 Mils。 

A 345 

線路佈線考慮 PCB 製作要考慮避免 T 型線避免小於 90 度避免直角線VIA(貫孔)越少越

好兩相臨線寬差距大安全間距要大 1 倍佈線距板邊致少 50mil。 

(A)  (B)  (C)  (D) 。 

B 346 PCB 上導線的寬度主要由何因素決定？(A)電壓差 (B)電流大小 (C)電阻大小 (D)成本高低。 

A 347 PCB 上導線間的距離主要由何因素決定？(A)電壓差 (B)電流大小 (C)電阻大小 (D)成本高低。 

A 348 標準銅箔厚的 PCB 線寬 1mm 其限載電流約?(A)1A (B)2A (C)0.5A (D)0.25A。 

D 349 

PCB 佈線的一般原則下列何者為非? 

(A)相同零件之擺放方向應儘量一致 (B)熱敏元件與散熱元件應相互遠離 (C)元件安排應配合

PCB 外形 (D)散熱元件應集中在一起。 

C 350 

在 PCB Layout 裡，要將電路板的顏色改為綠色，下列何者為非？ 

(A)啟動 Setup/Display Colors 進入 (B)按 Ctrl + Alt + C 鍵 進入 (C)在顏色對話盒選擇 Default Palette

鍵更改 (D)在顏色對話盒選擇 Palette 鍵更改。 

D 351 
高品質的旁路電容，通常為 0.1uF 與多少電容值的電容並聯在每一個電源平面與地平面之連接

處?(A)10uF (B)1uF (C)0.01uf (D)0.001uF。 

A 352 PCB LAYOUT 設計中走線的轉彎角度，下列何者最優？(A)鈍角 (B)直角 (C)銳角 (D)以上皆是。

C 353 
在 PADS Layout 中從 File/Import 中下列何者類型檔案無法引入？ 

(A)Protel 之 PCB 檔 (B)P-CAD 之 PCB 檔 (C)ORCAD 之 PCB 檔 (D)CADSTAR 之 PCB 檔。 

D 354 

下列電磁干擾的描述何者錯誤? 

(A) 過度的電磁干擾會形成電磁污染，危害人們的身體健康，破壞生態平衡 (B) 電磁干擾傳輸

有兩種方式：一種是傳導方式；另一種是輻射方式 (C) 抑制干擾傳播的技術包含如遮罩、接

地、搭接、合理佈線等方法 (D) 90％的電磁相容問題是由於元件特性和裝置容量問題所造成

的。 

C 355 
電磁相容是指設備或系統在其電磁環境下能正常工作且不對該環境產生電磁干擾的能力‧請問

其英文簡寫為?(A)EMI (B)IEC (C)EMC (D)EEC。 

B 356 

高速信號電路板的設計，為消弭信號的延遲誤差，在佈線時會設計等長的佈線方式(蛇線)。請

問下列何者佈線最不適當？ 

(A)  (B)  (C)  (D) 。 

B 357 
為避免產生電磁干擾，印刷電路板中之接地迴路應如何？ 

(A) 須為一封閉之迴路 (B) 不可為一迴閉之迴路 (C) 無所謂 (D) 只要不構成線圈狀即可。 

B 358 
在多心電纜中，由於導線間電容耦合而造成互相干擾的現象稱為什麼干擾？ 

(A)電磁干擾 (B)串音干擾 (C)雜訊干擾 (D)輻射干擾。 

D 359 
PCB 佈局時，不同類型電路要分在不同區域，其主要目是什麼？ 

(A)容易判斷 (B)幫助走線 (C)節省空間 (D)減少干擾。 

C 360 磁屏蔽材料應具備何種特性？(A) 磁偏角大 (B) 磁滯損失大 (C) 導磁係數大 (D) 剩磁大。 

D 361 

差動信號佈線方式，下列何者敘述較不正確? 

(A)兩條信號走線要等長 (B)兩線要在同一走線層，保持平行 (C)兩線要在上下相鄰兩層，保持

平行 (D)兩線長度不可相等。 

C 362 
下列何者不影響多層高速電路板銅箔走線的特性阻抗? 

(A)銅箔走線寬度 (B)電路板玻纖介質的介電常數 (C)銅箔走線長度 (D)銅箔走線厚度。 

C 363 

為降低 IC 的電磁干擾問題，在做電路板設計時，旁路電容擺佈何處？ 

(A) 靠近 IC 的訊號輸入端 (B) 靠近 IC 的訊號輸出端 (C) 靠近 IC 的電源接腳 (D) 靠近 IC 的接地

接腳。 

C 364 
當為兩層板 PCB 設計時，高頻電路應以控制下列何者為主要目標? 

(A)Layout 形狀 (B)路徑長度 (C)信號迴路之表面阻抗 (D)電源迴路。 

D 365 
FCC 及 DOC 規範在 450KHz 至多少頻率範圍間為電源線傳導干擾? 

(A)1MHz (B)10 MHz (C)15 MHz (D)30 MHz。 

D 366 除了所需的信號以外而出現在電路內的任何電氣訊號稱為？(A)輸入 (B)輸出 (C)接地 (D)雜訊。

D 367 
接地環路造成雜音源，應如何處置？ 

(A) 增加另一接地環路 (B) 使用差模扼流圈 (C) 擴展環路面積 (D) 移除一個接地端。 

C 368 多層板之電源層比較接地層板邊小，其目的為何？ 
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(A) 連接電源方便 (B) 產生擺置元件空間 (C) 防止輻射干擾產生 (D) 增加電容量。 

C 369 
目前經濟部標準檢驗局檢測 EMS 的相關標準依據? 

(A)ANS3548 (B)GB4943 (C)CNS13438 (D)EN55022。 

B 370 
避免有 T 型佈線及不均勻的佈線以防止何情況產生? 

(A) 產生尖波 (B) 反射電壓 (C) 使電流不均勻，線路會發熱 (D) 無不良影響。 

D 371 
高頻線路避免有長距離的平行走線，耦合電容加大較會產生何情況? 

(A) 無不良影響 (B) 使電流不均勻，線路會發熱 (C) 反射電壓 (D) 產生尖波。 

B 372 
高電壓、高溫、危險物體等，應漆有何種顏色三角警告標示符號表示？ (A) 黃 (B) 紅(C) 藍 (D) 

綠 。 

B 373 
由陰極射線管構成的螢幕，會射出什麼，它可能引發血癌之類的疾病？ (A) X 光 (B) 低頻電磁

波  (C) 高頻電磁波  (D) 紅外線。 

A 374 使用滅火器應站在？ (A) 上風 (B) 下風 (C) 逆風 (D) 側風。 

C 375 
依勞工安全衛生設施規定，每一勞工至少應有 5.7 立方公尺工作場所，且每分鐘至少需要有多

少的新鮮空氣？(A)0.2 立方公尺  (B)2 立方公尺  (C)0.6 立方公尺  (D) 6 立方公尺。  

B 376 
失能傷害是指因受傷而損失的工作時間超過多久？(A)48 小時  (B)24 小時  (C)12 小時  (D)8 小

時。 

B 377 
依據國際電氣標準所定，E 種絕緣材料之最高使用溫度為(A)105℃  (B)120℃  (C)130℃  

(D)180℃。 

A 378 

下列何者不是勞工安全衛生法規定之必要安全衛生設備？ 

(A) 防止颱風、地震引起之危害  (B) 防止電﹑熱及其他之能引起之危害  (C) 防止高壓氣體引起

之危害  (D) 防止監視儀表﹑精密作業等引起之危害。 

D 379 

下列對工業用標示顏色所代表之意義的使用說明，何者為錯誤？   

(A) 紅色表示防火設備、禁止  (B) 黃色表示注意、警告  (C) 綠色表示安全、救護設備  (D) 藍色

表示放射性危險。 

C 380 選擇使用滅火器材，主要是依據下列何者因素? (A) 風向 (B) 場所 (C) 燃燒物 (D) 氣候。 

B 381 

火災發生時，下列何者不是正確的處置方法？  

(A) 應依逃生路線選擇最近的安全門疏散  (B) 為求迅速疏散可使用電梯  (C) 不可停留在逃生路

線的中途  (D) 不可再重回火災現場。 

C 382 
下列措施中何者不能防止靜電對電子元件之破壞？ 

(A)桌面舖導電性桌墊  (B)人員帶接地手環  (C)穿平底膠鞋  (D)使用離子吹風機。 

B 383 
電源關閉後，為什麼要等數秒鐘後再開？ 

(A) 除去靜電  (B) 使電路恢復穩定狀態  (C) 讓開關休息  (D) 避免過熱。 

D 384 人體器官對電擊的承受，最易使之致命的是何種部位？ (A) 手  (B) 腳  (C) 肺  (D) 心臟。 

A 385 
含油性電氣設備著火而電源無切斷時，應可使用下列何種方式滅火？ 

(A) 二氧化碳滅火器  (B) 泡沫滅火器  (C) 濕棉被  (D) 水。 

B 386 我國專利法採行？  (A) 先發明主義  (B) 先申請主義  (C) 先實施主義  (D) 以上皆非。 

C 387 

關於資訊安全中密碼設定之描述，下列敘述何者為正確？  (A) 密碼應以明確、人能看得懂之格

式儲存在固定檔案中，以方便當事人遺忘時可以查詢 (B) 密碼之編定應有一定之規則可循 (C) 

密碼須定期加以更換 (D) 以上皆是。 

B 388 
著作權登記應向那個機關申請？ (A) 教育部 (B) 經濟部智慧財產局 (C) 經濟部中央標準局 (D) 內

政部警政署。 

C 389 
何者不屬於著作權登記申請書的範圍  (A)申請人國籍  (B)申請人姓名  (C)申請人作品售價  (D)申

請人作品完成日。 

B 390 

由廠商在其生產或輸入應回收商品或容器上標示，以方便民眾辨識回收的標誌為？ 

(A)  (B)  (C)  (D) 。 

A 391 

下列圖案中，何者為我國的環保標章？ 

(A)  (B)  (C)  (D) 。 

D 392 
依廢棄物清理法，廢電子電器、廢資訊物品經處理後，其資源回收再利用比例應達之百分比為

多少？始可向資源回收管理基金申請回收清除處理補貼。(A) 40% (B) 50% (C) 60% (D) 70%。 
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C 393 
空氣污染防制法中，二氧化硫(SO2)的「小時平均值」標準規定為多少 ppm 以下？(A) 0.03 ppm 

(B) 0.1 ppm (C) 0.25 ppm (D) 0.5 ppm。 

B 394 
依水污染防治法設置水質監測站，其採樣頻率，以每季一次為原則，其監測項目不包含下列何

項？(A) 水溫 (B) 水清澈度 (C) 溶氧量 (D) 氫離子濃度指數。 

C 395 
使用綠色電腦的好處．除符合地球生態外．尚能節省電腦所用之？  (A) 硬體費用 (B) 維修費  

(C) 電費  (D) 軟體費用。 

C 396 
能源之星專案是以個人電腦在非工作模式下能節省多少耗電標準？(A)70﹪~90﹪(B)25﹪~50﹪ 

(C)50﹪~75﹪ (D)60~80﹪。 

D 397 
環保署針對各行業之廢棄物訂有回收清除處理方法及設施標準，其中不包括：(A) 廢資訊物品 

(B) 廢機動車輛 (C) 廢乾電池 (D) 廢傢俱。 

B 398 

廢棄電路板處理哪一項錯誤(A) 包括金屬、塑料、玻璃等回收價值高 (B) 一頓的晶片電路板可

以分解出 130 公斤黄金，20 公斤錫，0.4 公斤銅 (C) 電子垃圾裡絕大部分成分都可以回收利用 

(D) 電路板中富含玻璃纖维和樹脂，分離後的廢渣還可用於建材原料。 

C 399 

依據歐盟有害物質限制指令(RoHS)，其規定限用物質與濃度下列何者錯誤? (A) 鉛，規範濃度

1000ppm (B) 汞，規範濃度 1000ppm (C) 鎘，規範濃度 1000ppm (D) 六價鉻，規範濃度

1000ppm。 

B 400 
依據歐盟廢電機電子設備指令(WEEE)，其產品範圍分為 10 大類，以下何者非 10 大類範圍? (A) 

大型家用電器 (B) 大型機械設備 (C) 照明設備 (D) 玩具、娛樂及運動器材。 

 


